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Doctor Web

Doctor Web develops and distributes Dr.Web® information
security solutions which provide efficient protection from malicious
software and spam.

Doctor Web customers can be found among home users from all
over the world and in government enterprises, small companies
and nationwide corporations.

Dr.Web antivirus solutions are well known since 1992 for
continuing excellence in malware detection and compliance with
international information security standards. State certificates and
awards received by the Dr.Web solutions, as well as the globally
widespread use of our products are the best evidence of
exceptional trust to the company products.

We thank all our customers for their support and
devotion to the Dr.Web products!
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1. Introduction

1. Introduction

is an anti-virus solution designed to restore the
system after it was crippled as a result of virus or malware activity.
To protect the system from such situations, it is necessary to have
constant reliable protection using the most advanced anti-virus
technologies.

The cutting-edge technologies provide solid anti-virus
protection for your home computer, office network, and large
corporate networks. The solutions are distinguished for

their low system requirements, compactness, operation speed and
reliability in detection of all types of malware.

company offers the following solutions for constant
protection against viruses, malware and spam:

e Protection of corporate networks (

)
e Protection of workstations, clients of terminal servers, clients
of virtual servers and clients of inbuilt systems (
)i
e Protection of file servers and application servers (both virtual
and terminal) ( );
e Protection of mail ( );
e Protection of SMTP and internet gateways (
)i
e Protection of mobile devices (

).

For more information about company products, visit the

1.1. Dr.Web® LiveUSB

utility allows to create a boot flash drive with a
portable Linux-based operating system and inbuilt software intended


http://products.drweb.com/?lng=en
http://products.drweb.com/?lng=en
http://products.drweb.com/?lng=en
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1. Introduction

to facilitate computer scanning and curing, working with the file
system (Dr.Web LiveUSBE anti-virus solution), viewing and editing
text files, viewing web pages, and sending and receiving e-mail
messages. Using boot flash drive you can restore the system when
loading a computer from a hard drive is impossible due to high virus
activity.

Dr.Web LiveUSB is distributed as a drwebliveusb. exe
executable file.

1.2. Creating Emergency System
Recovery Disk

Creating emergency system recovery disk on a USB drive

1. Connect the flash drive. It takes maximum ten seconds for a
connection to be registered.

2. Rundrwebliveusb. exe.

3. The program will detect all available USB drives automatically
and suggest you to select the suitable one. If necessary you
can format the selected USB drive (a notification wil be
displayed before formatting).

sovevs T ==

Create Emergency System Recovery Disk on a USE drive

Dr.Web LiveUSB helps you recover operating system from viruses and other security threats
even when you cannot boot itin the usual way.

Select 3 USB drive:

[Removable Disk (E:) 3.22 GB free of 7,48 GB

[ Format USB drive before creating Dr.Web LivelsSB

License agreement

Generate Dr.Web LivelUSB

7



1. Introduction | 8

To view the License Agreement follow the corresponding
link in the program window (default browser will be started).

4. Press Generate Dr.Web LiveUSB to create a boot flash
drive.

5. Files will start to copy automatically.
6. Press Exit to close the program window.

womass

Create Emergency System Recovery Disk on a USB drive
Dr.Web LivelSE created successfully.

Dr.Web LiveUSB created successfully.

To load with emergency recovery disk restart computer and choose "Load from
fiash drive” in boot menu,

Generate Dr.webLiveuss i gdt

1.3. System Requirements

Minimum system requirements to start the Dr.Web LiveUSB anti-
virus solution:

e 386 processor

e Minimum 128 MB of RAM (64MB to load in safe mode)
e a USB flash drive with minimum 256 MB of free space

To boot from USB flash drive, BIOS of your computer must support
USB-HDD as a boot device.
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1. Introduction

1.4. Launching Dr.Web LiveUSB

Make sure that your computer is set up to boot from the USB flash
drive, created with . At start a menu is displayed
from which you can select the load mode.

Using the arrow keys on your keyboard select one of the following
options and press ENTER:

e To launch the GUI version of the anti-virus
solution, select DrWeb-LiveUSB.

e To launch the command line version of the
anti-virus solution, select DrWeb-LiveUSB (Safe Mode).

e To load your computer from the hard drive without launching

, select Local HDD (cancel launching of
, launch the system from the 0 partition of the

0 drive (hd0,0)).

e To test memory (for example, when you computer is

extremely unstable and restarts at random), select Test
Memory.

The standard mode is preferable because of its user-friendly
interface and improved functionality. The bigger part of this manual
describes working in this GUI mode. The safe mode is intended for
experienced users familiar with UNIX-based operating systems and is
used when the GUI fails to load.

Press TAB to edit each option manually.
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2. Dr.Web LiveUSB Graphic Shell

2. Dr.Web LiveUSB Graphic Shell

The

software includes a graphic shell with a

window-based interface similar to the Linux operating system GUL.

By default, the desktop with the trademark for the
background contains icons of applications included in

The taskbar (a horizontal bar in the bottom) contains

System menu button @

Quick Launch icons for inbuilt applications
Desktop switching icons

Icons of currently used applications
System clock (in the right corner)

includes the following basic applications:
Firefox browser;
Sylpheed mail client;
Midnight Commander file manager;

command-line terminal to work directly from under the graphic
shell;
Leafpad text editor.

10



2. Dr.Web LiveUSB Graphic Shell | 11

Dr.Web Live CD

= --- @ (Orweb Scanner] ||Eme - ~) |

Click an area for details

You can start the main components by

o double-clicking the icon of the respective component on the
desktop (by default, basic components are represented on
the desktop);

e clicking the icon of the respective component in the taskbar
(except for the file manager and Dr.Web Scanner for Linux
).

e selecting the respective component on the system menu.

To open the system menu, click the system menu '.' button in
the taskbar.

User Manual
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2. Dr.Web LiveUSB Graphic Shell

ﬂ Drweb Scanner

A% Report Bug

@ Help

@ Metworl >
4{'9 Settings >
* Utility >

; Restart

x& Shut Down

& Eject & Shut Down

Exit
Click a command for info

You can access the desktop context menu named Openbox by
right-clicking the desktop.

Openbox
Lpplications  p
Desktops 3
OpenBox Config

Exit

Click an area for info

/& Forinformation on how to use Dr.Web Scanner for Linux, select
A Help fromthe systemmenu or use the Help menu of the Scanner
main window.

After the graphic shell has been loaded, the main window of Dr.
Web Scanner for Linux opens by default. Dr.Web Scanner for

12
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2. Dr.Web LiveUSB Graphic Shell

is designed to check all Windows root partitions for viruses.

2.1. Settings

The settings are available through the Settings
item of the and include the following options:
. which allows you to configure appearance
of the taskbar
o which allows you to configure
network
o which allows you to configure
the GUI
. which allows to configure the X Window
System

To configure settings, select a corresponding item in the menu.
The settings window opens.
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2. Dr.Web LiveUSB Graphic Shell

2.1.1. Taskbar Configuration

This windows allows you to configure the position, size, and special
effects in appearance of the taskbar (on the General tab) as well as
configure installed GUI plugins (on the Plugins tab). See Figure 2.

Figure 2. Taskbar configuration

S fbpanel configarator =l1a]|=]
General Plugins
Position
Edge: |Bott0r‘n C|
Allignment: |Left - | Margin: EEl
Size _
width:  [100 || % of edge ¢
Height: [30 |:| |pixe|s 2 |
Effects

[[] Transparency

G

Properties
Set Dock Type
Do not cover by maximized windows
[] Autohide

</ apply || ¥close |

14
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2. Dr.Web LiveUSB Graphic Shell | 15

Position Specify values for the following parameters:
o the taskbar position on the screen (Edge)
¢ alignment of the taskbar elements (Alignment)
e the taskbar margine (Margine)
Size Adjust the the taskbar width Width and Height.
Effects Adjust the taskbar Transparency and Color settings.
Properties  Specify values for other parameters:
e fype of the taskbar (Set Dock Type)

e taskbar covering options (Do not cover by
maximized windows)

¢ hiding options (Autohide)

2.1.2. NetWorks Configuration

This window allows you to configure IP protocol settings manually or
receive them via DHCP. See Figure 3.


http://en.wikipedia.org/wiki/Dock_(computing)

2. Dr.Web LiveUSB Graphic Shell

Figure 3. Networks configuration

= et EEE!I

drweb. com nonel

localdomain

192.168.0.0

[] DHCP

[k
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2.1.3. Openbox Configuration Manager

This window allows you to configure the Openbox GUI including
colour schemes, desktop parameters etc. See Figure 4.

Figure 4. Openbox configuration

m Openbox Conhiguration Manager, = E B

‘Theme ‘ Theme

W :

Appearance ] Inactive [J] o] (=]
m Active 2/ =

Windows =

Clearlooks —

Mormal » =

Move & Resize Disabled
Mouse
Desktops

Clearlooks-Olive
Margins

Selected

Dock m Inactive

l “nstall a new theme... _i
l

[Ecreate a theme archive (.obt)...



http://icculus.org/openbox/index.php

Ty
)
.‘ﬁ

2. Dr.Web LiveUSB Graphic Shell

s,
X5

2.1.4. X Window Configuration

This window allows you to configure the system (screen
resolution, type of the video driver and the mouse, keys for shifting
the keyboard layout). See

Figure 5. X Window configuration

[~ SxongHioas [=]{o] E!I

serial Mouse Ctrl-shift

VINWEre
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2. Dr.Web LiveUSB Graphic Shell

2.2. Inbuilt Applications

This section describes applications available within the
anti-virus solution. Access to these applications can be
gained via Network and Utility options of the .

The Utility option on the system menu opens the drop-down list:

. - create boot flash drive;
e Leafpad - open the inbuilt text editor (notepad);
. - open the file manager;

e Terminal - open the command-line terminal.

The Network option on the system menu opens the drop-down
list:

. - open the inbuilt browser;

. - open the inbuilt mail client.

2.2.1. Browser

Even though your computer cannot be loaded from the hard drive,
the Mozilla Firefox web browser included in will
allow you to view web sites and save the pages. See . You
will be able to view the saved pages after the OS is fully restored
and loaded.

19



2. Dr.Web LiveUSB Graphic Shell

) An Internet connection via the Local Area Network is required to
A access the web pages with the inbuilt browser.

The browser default start page is the Doctor Web official web
site.

Figure 6. Inbuilt Browser

d entizpam prot ection, - Mozills Firefor

e Ecit View Higtory Bookmarks Tools Help

@ - - @ %] m- E itk drweb. corny ‘v| |'|‘3:\ng\é

4 Getting Started  [5] Latest Headines

Products  Solutions Dr.Web AV-Desk  Estore  Downloads

Dr.Web® AV-Desk™
the best service-product

by PC Magazine Russia

Done

2.2.2. Mail Client

The inbuilt Sylpheed mail client will enable you to carry on e-mail
correspondence in full volume. See Figure 7.

An account at the mail. drweb. com server is preinstalled in the
Sylpheed mail client to enable user send messages. You can create
additional accounts to maintain correspondence.

To create a new account, select Configuration menu -> Create
new account. Enter all information necessary to enable mail
transfer, such as sender's e-mail address, mail sending and receiving
parameters (SMTP and POP3 protocols respectively), and
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2. Dr.Web LiveUSB Graphic Shell

accompanying information.

To work with several accounts, you can create separate maiboxes.
To do this, select File menu -> Mailbox -> Add mailbox. In the e-
mail box properties specify what account is to be used: on the
context menu of the mailbox select Properties -> Compose tab -
> Account drop-down list -> specify the account.

Figure 7. Mail client

EIEIEJ
File Edit Wiew Message Tools Cenfiguration Help
&Get @Get all Compose ~
- &y —
W v @ 0 Subject From Date Size
@ Sent
[ Drafts
@ Queue 3
& Trash
=] v
From:
Subject:
| | <= Drweb

Sylpheed provides a secure connection to the mail server through
the SSL and TLS protocols.

When your OS is damaged and you cannot use your customary
tools, this mail client included in will allow you to
keep up a correspondence through your registered e-mail account
until the problem is solved.

21



At 4
‘ﬁ

»
~

¥

2. Dr.Web LiveUSB Graphic Shell

2.2.3. File Manager

The inbuilt Midnight Commander file manager is similar to the
Norton Commander file manager. See . By using full screen
display mode it provides an intuitive user interface to the operating
system and serves as a useful tool for operations with files, suitable
for users with any level of experience, from a newbie to a guru.

Homepage:
Figure 8. File manager
mic == EIEIES
Eeft File Command Detiuns Right

4 >
Name

.config
.drueb
_fbpanel
.icons

. idesktop
local

-mc

mozilla
.sylpheed-2.0
Hail

e A O T e T e T M
M
Bl U000 ] O s md U omd =] =

hority
*.Xdefaults

druwebh ™ #
1Help  ZMenu  SWiew  4Edit SCopy  GBRenMov TMkdir &SDelete 9SPullDn 10QEuUit
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3. Using Scanner from Graphic Shell

3. Using Scanner from Graphic Shell

This section describes Scanner parameters and settings, and how to
use it from a Graphic Shell.

3.1. Main Options

You can access the main options of the Scanner via the Options

button ## on the toolbar or via the menu in the Scanner main
window: Settings -> Options. In this window you can adjust the
Scanner GUI, specify actions taken upon detection of infected or
suspicious objects and set up Scanner interaction with the OS and
various modules of the anti-virus complex. See

23



1"4
1ﬂ

e
$

3. Using Scanner from Graphic Shell

Figure 9. Scanner main options

N DEWeEb S cannen - Options: x|

{5 General ‘  AlActions ‘ Checking

¥ Programs ‘&Suppor’c ‘

Path to Scanner: [fcptfdrwebf ] E]

Save all settings at exit

Scanner
Excluded paths:

fproc l +Add excluded path l
Isys
Jdev l- Delete excluded pathl

Jrootf.drweb/

Path to key: [fcptfdmebfdmebﬂ.key l l | = Browse ... l

[ &Set default ] [ Qafok l [ < apply ] l xCancel l

Main settings are divided between several tabs:

e General - general Scanner settings;

e Actions - adjustment of program's reactions upon detection of
virus threats or malware;

e Checking - adjustment of scan modes for files, possibility to
save current settings and restore the defaults;

e Programs - adjustment of interaction with other anti-virus
components and inbuilt programs;

e Support - updates and technical support.

In the bottom of this window, the following control buttons are
located:

24
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3. Using Scanner from Graphic Shell

e Set default - discard the user settings and set the default
ones;

e Ok - save the changes and return to the main window of the
Scanner;

e Apply - save the changes and stay in the settings window;

e Cancel - return to the main window of the Scanner and
discard the changes.

3.1.1. General Tab

By default, the main options window opens on the General tab.
See

At the top of the General tab, you can specify the path to the
Scanner. In the Path to Scanner entry field, type the path or click

the button D and select the path via the file system explorer.
Using the sane algorithm specify the path to the license key file in
the Path to key entry field, if necessary.

As usual, the path to the Scanner specified by default is correct
and there is no need to change it.

Clear the Save all settings at exit checkbox, if you want the
settings to be saved in the configuration file only by clickihg the
Save settings button (refer to tab). By default, this
checkbox is selected and the settings are saved every time the
Scanner is closed.

25
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3. Using Scanner from Graphic Shell

Figure 10. General options

N DEWeEb S cannen - Options: x|

@ General ‘ A Actions ‘ Checking

¥ Programs ‘&Suppor’c ‘

Path to Scanner: [fcptfdrwebf ] B

Save all settings at exit

Scanner

Excluded paths:

fproc l +Add excluded path l
Isys
Jdev I— Delete excluded pathl

Jrootf.drweb/

Path to key: [fcptfdmebfdmebﬂ.key l l | = Browse ... l

[ &Set default ‘ [ Q‘:)(?Ok ‘ [ < apply ‘ l xCancel I

You can specify the list of paths which you do not what to scan. To

add a certain directory to the list of exclusions, click Add excluded
path. A window for selecting the path will open.

Inttially the path selection pane (at the top) contains the following
buttons:

2 Type a file name - opens the file name entry field to
add a path to file (to close the field, click the button again).

. B File System - opens the list of Dr.Web LiveUSBE file
system partitions.

As you view file system objects, the buttons for the directories
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3. Using Scanner from Graphic Shell

passed («bread crumbs») appear on the path selection pane (at top
of the window). Click a button to open the respective directory.

To add an object as a shortcut, select necessary directories in the
file system explorer and click Add button. To remove a shortcut,
select the shortcut in the Places list and click Delete button. You
can use the shortcuts for navigation through the file system.

When done with selections, click OK to add the selected directory
to the list of objects to be excluded from scan and close the
window, or click Cancel to close the window without saving the
changes.

To delete an object from the list, select this object in the list of
excluded paths and click Delete excluded path.

When you are done, click Apply to save the changes and leave the
dialog box open.

3.1.2. Actions Tab

On the Actions tab, you can adjust reactions of the program on
detected virus threats or some other malware. See

By default, the Report action is set for all types of objects.
Information on all the detected objects is displayed in the report
field of the Scanner main window (see the section).
You can select actions to be applied to the certain types of objects
manually using the Cure and Delete buttons under the report field.

27
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3. Using Scanner from Graphic Shell

Figure 11. Actions settings

N DEWeEb S cannen - Options: x|
@:'General AlActions Checking | | Programs £\ Support

Infected: | Cure s | Malware
Suspicious: | Report < | Adware: | Report s |
Incurable: | Report o | Dialers: | Report 2 |
Infected archives: | Report = | Jokes: | Report = |
Infected containers:[ Delete < | Riskware: | Report s

ﬁ|

L

Infected mail: | Report o Hack‘tools:| Report

| i Set default | | cgj;’ ok | | <Z apply | | %Cancel |

You can change the program's reaction on detected virus threats or
malware on the Actions tab. To do this, select the necessary
action from the drop-down list near the respective type of object.
Depending of the threat type these lists contain different sets of
available actions:

e Report - report about the detected threat in the report field
of the Scanner main window.

e Cure - try to cure the file and restore it to the state before
the infection. If curing is impossible, then the action specified
for incurable objects will be applied.

¢ Delete - delete the file.

28
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3. Using Scanner from Graphic Shell

When infected or suspicious files are found in archives, emails or
} ! . containers, the program applies the assigned action to the whole
object and not to a single file inside the object.

The Scanner can detect the following types of malware:

o Adware - used to display advertisements;

o Dialers - used to create an unauthorized connection to paid
Internet sites over the dial-up modem;

¢ Jokes - may scare or distract the user;

o Riskware - potentially harmful programs which may be used
by the intruder;

o Hacktools - programs intended to facilitate unauthorized
access to computers.

When you are done, click Apply to save the changes and leave the
dialog box open.

3.1.3. Checking Tab

All main Scanner settings are located on the Checking tab of the
Scanner main window. See . Here you can save necessary
settings, load the settings from the user configuration file drweb.

ini and access Advance options section with advanced Scanner
settings.

29
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3. Using Scanner from Graphic Shell

Figure 12. Checking settings

D EWeEb S cann e options x|

@?General ‘iActions | = Checking

-Check mode
() Fast check

O Full check

@ |Advanced mode|

=

Save Settings

=

Load Settings

%

Advanced Options

¥ Programs ‘&Support ‘

This mode is intended for
experienced users only.

It allows to adjust the parameters which
determine the checking thoroughness
level manually.

Click the Advanced Options button below
to customize the parameters.

[ Q Set default ] [

< ok H < apply H 2 cancel l

The Checking tab includes

e Check mode pane;
e check modes description pane;
e settings control buttons.

A group of radio buttons named Check mode determines the

scanning mode (the check severity level):

30
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3. Using Scanner from Graphic Shell

o Fast check - only the files which internal structure allows
them to contain virus code are scanned; archives and symlink
objects are not scanned; the heuristic analyzer is disabled.
The scanning process in this mode is a lot quicker than in the
Full check mode, at the expense of reduced protection
reliability.

e Full check - all selected objects are scanned, including
archives and symlink objects; the heuristic analyzer is enabled.
This mode is recommended for everyday computer scanning.
It is slower than the Fast check mode, but provides a much
higher level of protection.

¢ Advanced mode - in this mode you can manually adjust the
parameters which determine the check severity level. It is
intended primarily for experienced users. When this mode is
selected, the Advanced Options button becomes available
in the bottom-left of the tab. Click the button to adjust the
parameters (see the section).

When you select any mode, its detailed description is given in the
right part of the tab.

To save changes to the settings in the configuration file, click Save
Settings. The new settings will now be used each time program
starts or settings are loaded from the user configuration file.

If you restart your system without saving the new settings, any

changes made to the configuration file will be lost and all the

parameters will be reset to the default, as when

was written to the disk or another medium. Please note, that if you

select the Save all settings at exit checkbox on the General

tab, the settings will be saved automatically every time the
is closed.

To load the settings from the configuration file, clck Load
Settings.

31
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3. Using Scanner from Graphic Shell

When the program starts settings from the configuration file are
/ ! ;, loaded automatically. Use the Load Settings button only to
discard the new changes to the settings you have made.

In the program's configuration file in the [ GUI] section settings of
the GUI module are stored. For more information about the
configuration file refer to the

documentation.

3.1.4. Programs Tab

On the Programs tab, you can adjust Scanner interaction with the
other components of . See

The Programs tab includes three panes:

e Updater - contains information necessary for Updater
adjustment;

¢ Mail - used for adjustment of call options for the mail client;

e Browser - used for adjustment of call options for the web
browser.

On the top Updater pane

o If necessary, you can edit the path to the directory with the
updating utility. To do this, specify the path in the Path to
directory with file update.pl entry field or click the button

D and select it via the file system explorer.

o If a proxy server is used to receive updates, type the login
and password to the proxy server in the Proxy login and
Proxy password entry fields correspondingly.

On the Mail pane, you can type a command to start the mail client
in the batch mode and edit it, if necessary. Under the entry field,
you can find possible parameters to be used with this command and
their descriptions.

On the Browser pane, you can type a command to start the

32
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3. Using Scanner from Graphic Shell

browser and edit it, if necessary. Under the entry field, you can find
possible parameters to be used with this command and their
descriptions.

When you are done, click Apply to save the changes and leave the
dialog box open.

3.1.5. Updating and Technical Support

On the Support tab, you can update virus databases, contact
technical support, send information about a bug or a suspicious file
for check to , and view program info. See

The left pane of the Support tab contains buttons to perform the
following actions:

e Start the Updater. Click Update.

e Open the official . Click www.drweb.com.
e Open the in the web browser window. Click
Forum. The inbuilt browser will open at the page of the
forum.

e Send a request to the technical support. Clck Request to

support. The inbuilt browser will open at the page of the
support service.

. by e-mail. Click Bug report. The inbuit mail
client will open to send a mail message.

e Send files that are probably infected by unknown viruses for
analysis to the laboratory. Click Send file for check.
A file manager window will open.

The right pane of the Support tab contains info about the version
of the program, loaded virus databases, last update time and license
key number. This information is refreshed after every update.

33
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3. Using Scanner from Graphic Shell

To update Dr.Web virus databases, visit the aforementioned
web sites, send e-mail messages and files, a connection to the

Internet is required.

In case you receive a notification that the browser or the mail client
is not found at the attempt to follow any of the links above, adjust
properly paths to the executable files of the browser and mail
client. To do this, on the Settings menu select Options ->
Programs and enter necessary data.

Figure 14. Support tab

= DRWeb Scanner - Gphions

x|

General ‘ | A Actions ‘ ~ Checking ‘ f‘ Programs | £\ support

‘ . Update ‘

[ Qmwv.dmeb.com l

[ @Forur‘n l

[? Request to supportl

[ A\ Bug report l

[ i), send file for check l

Shell version:
Engine wversion:

4.44.0,10060 <AP2.2>
5.0.0.12182 <APl:2.2>

Copyright(c) Igor Daniloff, 1992-2009

Virus databases
dwrs0005 vdb
dwrs0004 vdb

o — AL

Total viruses records: 576023

Last update time: unkrown

Key file: Joptjdrwebjdrweb32 key
Key file number:

Working period:  unknown

l Q Set default ] [

< ok

H <Zapply H & cancel l
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3. Using Scanner from Graphic Shell

3.2. Advanced Options

Experienced users may adjust scanning parameters by themselves in
the section.

To set individual scanning parameters

1.0n the Scanner Settings menu, select Options and then
select the Checking tab.

2.0n the Check mode pane, select Advanced mode.

3.The Advanced Options button in the bottom-left of the
window becomes available. Click the button to access the
settings.

4.0r directly from the Scanner Settings menu select the
Advanced mode option button.

5.Advanced options item in Settings menu becomes
available. Select it to access the settings.

The advanced options menu allows to adjust manually paths to
directories used by the various Scanner components, specify types
of files for scan, set up logging procedure, etc. See .
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3. Using Scanner from Graphic Shell

Figure 15. Scanner advanced options

I Dr.Web Scanner - Advanced options = EE

Paths|| File types | Log file | Archive | Other

Wirus databases

Jroot{.drweb/local-basesf+ vdb +Add virus database

jroot{.drweb/local-basesf VDB
== Delete virus database

Engine path: [;root;.dnr\rebflocal-lib,fdmeb32.dII ] =

Update path: [;root;.dm’eb{update ] —

Termnp path: [;root;.drwebftemp ] =

L set default 7 ok < apply Cancel
=g

The advanced options are divided between several tabs:

e Paths - specify the paths to main Scanner modules.

e File Types - set the file types to be checked.

e Log File - set logging parameters.

e Archive - set limitations to actions to be applied to archives for
safety reasons.

e Other - adjust parameters managing computer workload,
select Updater's timeout and enable the heuristic analyzer.

In the bottom of the advanced options window, the following
controls are located:

o Set default - discard the user settings and set the default
ones;

e Ok - save the changes and return to the main window of the
Scanner;
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3. Using Scanner from Graphic Shell

o Apply - save the changes and stay in the settings window;

e Cancel - return to the main window of the Scanner and
discard the changes.

3.2.1. Paths Tab

By default, the advanced options window opens on the Paths tab.
See .

Figure 16. Paths tab

Paths|| File types | Log file | Archive | Other
Virus databases

jrootf.drwebjlocal-basesp+ vdb %Add virus database

jrootf.drweb/local-basesf* DB
== Delete virus database

Engine path: [,froot,f.dmeb{local—libfdmebﬂ.dII ] =

Update path: [,froot,f.drwebfupdate ] =

Temp path: [,froot,f.drwebftemp ] =

__1 Set default qj? ok < apply % Cancel

In the Virus databases list the location of databases with
is specified. By default, the databases are located in
the directory specified during the program installation. The Updater
module automatically puts updated databases to this directory.
However, if you wish to connect some additional databases
manually, you must add them to the Virus databases list. The
database files which have a non-standard extension should also be
added to this list even if they are located in the default directory.
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3. Using Scanner from Graphic Shell

To add a database to the Virus databases list, click Add virus
database. A window for adding a database will open.

By default, the list contains only two file masks: *. vdb; *. VDB (i
e. files with the . vdb or . VDB extensions only). You can also
specify only one * symbol to point to files with any extensions.

To delete a database from the Virus databases list, select it and
click Delete virus database.

If necessary, you can edit paths to the engine, the update
directory and the temporary files directory in the corresponding
input fields, or select these paths via the file system explorer by

clicking the button D next to the relevant field.

3.2.2. File Types Tab

On the File Types tab you can set up restrictions on the types of
files to be checked by the Scanner. See

On the Scan mode pane set the selection method for files to scan
using the group of option buttons:

e All - all files are scanned regardless of their types and internal
structure. This mode is set by default when you select Full
check on the tab of the Scanner settings section.

e By type - only files with the extensions specified in the File
types list are scanned. Executable files and files containing
macros are on the list by default. To add an extension to the
list, click Add file type, specify the necessary extension in
the opened window and then click Apply. To delete an
extension from the list, select it and click Delete file type.

38



Ty
)ﬁ

s,
\g:

A

3. Using Scanner from Graphic Shell

The Add file type and Delete file type buttons are
4= . active only when the By type check mode is selected.

e By format - files which internal structure allows them to
contain viruses, are scanned regardless of the names and
extensions. This mode is set by default when you select Fast
check on the tab of the Scanner settings section.

Below the pane you can select the following options to set up
additional restrictions for the scanning process:

e Select the Follow symlinks checkbox if you want the
Scanner to check the files, symbolic links to which are
included into the scan.

e Select the Check archives checkbox if you want the Scanner
to unpack archives and check the files inside (in the By
format mode archives should have a suitable format; in the
By type mode, the extension of both the archive and the
scanned file should be in the Fle types list).

e Select the Check e-mail files checkbox if you want the
Scanner to check attachments to e-mail messages.

All three of the above checkboxes are automatically selected in the
Full check mode and cleared in the Fast check mode (these
modes are availble on the tab of the settings section).
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Paths | File types | Log file | Archive | Other

Scan mode

File types
P +Add file type

O Al EXE
COM
@ By type| | oyq

[ )

wm Delete file type

i ov?
) By format
BAT

@

Follow symilinks
Check archives

Check e-mail files

_1. Set default qj;: ok < apply % Cancel

3.2.3. Log File Tab

On the Log file tab you can adjust logging parameters.See

On the Log File Name pane select whether the log should be kept
by or by the system service:

¢ File name - will log events to the file
specified in the entry field. You can edit the path to the log

file in the entry field or click the button D and choose the
path via the file system explorer.

e Syslog - the log will be kept by the Syslog system service.
If you select this method, you can specify the logging facility
and priority in the two drop-down lists below.
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3. Using Scanner from Graphic Shell

The following log facilities are available: Daemon | LocalO .. Local7
| Kern | User | Mail.

You can select between the following priority levels for logging:
Info | Notice | Alert | Warning.

A selected Limit log file size checkbox instructs that the log file
must not exceed the size specified in the entry field to the right.
After the maximum has been reached, old entries will be gradually
deleted to give space to the new ones. Clearing the checkbox wil
remove any limitation to the log file size.

It is recommended to keep the default Limit log file size option
y ! . selected and the default value in the Max log file size (512 Kb)
== unchanged.

In the Updater section you can edit the path to the log file of the
updating utility. Specify it in the Log file entry field or click the

button D and choose the path via the file system explorer.
In the Level of log drop-down list, you can select the required log

verbosity level. The following levels are available: Debug | Verbose
| Info | Warning | Error | Quiet.
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Figure 18. Log file tab

Paths | File types | Log file | Archive | Other

Log File Name
@ [File name

Jrootf.drwebjlogs/scanner.log

) Syslog

Limit log file size Max log file size: :| Kb

Updater

Updater log: [frootf.dmeb;logs;updater.log l —

Level of log: |Warning = |

—_1'. Set default qj;: ok < apply % Cancel

3.2.4. Archive Tab

On the Archive tab you can set limitations to actions which will be
applied to archives for safety reasons. See

The parameters on the Archive tab are designed to protect the
Scanner from «maibomb» attacks. They specify limiting values of
various archive characteristics, excess of which will lead to skipping
these archives from scanning in order to avoid exhaustion of system
resources.

If it is necessary to change the default settings, edit the values in
the following entry fields:

¢ Max compression ratio - by default is set to 5000;
¢ Max archive nesting level - by default is set to 8;
e Compression check threshold - by default is set to 5000
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3. Using Scanner from Graphic Shell

Kbytes. Smaller archives are scanned regardless of the
compression ratio;

o Max file size to extract - by default is set to 1024 Kbytes.
Larger archives will not be unpacked.

Figure 19. Archive tab

Paths | File types | Log file | Archive | other

Max compression ratio: [

£

g
Max archive nesting level: [8 |:|
Compression check thresheld: [5000 |:| Kb
Max file size to extract: [1024 |:| Kb
;. Set default qj? ok < apply % Cancel

3.2.5. Other Tab

On the Other tab, you can set parameters to adjust the computer
workload, select Updater timeout and enable the heuristic analyser.
See .

In the Scan priority group of option buttons, you can select the
priority of the scanning process compared to other system
processes.

In the Timeout entry field, you can edit the default awaiting time
of the updating utiity when trying to connect to the update
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3. Using Scanner from Graphic Shell

server.

Selecting the Heuristic analysis checkbox enables the heuristic
analyser mode (a method of virus detection based on the analysis of
actions specific for viruses).

In the heuristic analyser mode false positives are possible. All
objects detected by the heuristic analyser have the «suspicious»

4= status. The analyser is automatically enabled, if you choose the
Full check mode, and disabled in the Fast check mode.

Figure 20. Other tab

F DEWEDB Scannern - Advanced options M = E

Paths | File types | Log file | Archive | Other
Scan priority
) High

@ [Normal|
) Low

Updater

Timeout: |90 |C| sec

Heuristic analysis

i Set default qj? ok < apply ‘% Cancel

Click an area for details

3.3. Antivirus Scan

This sections describes how to scan your file system for viruses.
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3. Using Scanner from Graphic Shell

3.3.1. Starting a Scan

can be started in one of the following
ways:
e Automatically after the graphic shell is loaded
¢ Using the desktop icon
e Using of the corresponding item of the

After launch the Scanner main window opens. See

The Scanner allows to check all types of Windows partitions (FAT,
FAT32, NTFS) for viruses. By default, all available partitions of the
hard drive are selected for scanning.
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3. Using Scanner from Graphic Shell

It is strongly recommended to update the Dr.Web virus

ﬁ databases before scanning. To do this, click the Update Bases

& button.

By default, all the subdirectories in selected directories are
scanned. If you want to scan only files in certain selected
directories and partitions, excluding the content of the enclosed
directories (in spite of the possible infection), clear the Scan
subdirectories checkbox.

Figure 21. Main Scanner window

DrWeb Scanner,
File Settings Help

P EHE - 0% X

:+Add |

.—Delete|

[ e
M=o
‘.\ - Start

| Scan subdirectories

File | Status

To add an object to or remove an object from the list of objects for
scan, either click Add or Delete.
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The Delete button becomes available once you select an object.

If you do not want the Scanner to check a certain object, but you

want it to remain in the scanning list, clear the checkbox next to
this object.

When you click Add, a window opens, where you can select
objects to scan. See Figure 22.

Figure 22. File Manager window

* drweb-gui HEE]
# Create Folder
Places Name ~  Modified B
@ Recently Used
[ root
File System
hda
o= Add =
oK Cancel

Inttially the path selection pane (at the top) contains the following
buttons:

N E Type a file name - open the file name entry field to add
a file (to close the field, click the button again).

. 8 File System - open the list of Dr.Web LiveUSB file
system partitions.
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3. Using Scanner from Graphic Shell

As you view file system objects, the buttons for the directories
passed («bread crumbs») appear on the path selection pane (at top
of the window). Click a button to open the respective directory.

To add an object as a shortcut, select necessary directories in the
file system explorer and click Add button. To remove a shortcut,
select the shortcut in the Places list and click Delete button. You
can use the shortcuts for navigation through the file system.

When done with selections, click OK to add the selected directory
to the list of objects for scan and close the window, or click Cancel
to close the window without saving the changes.

To start scan of the selected objects, click Start (it wil turn to the
Stop button and scanning process will begin).

During scan the status bar in the bottom of the window reflects
the current program activity, for example, loading of virus databases
or the full path to the file being scanned at the moment.

To terminate scan, click Stop (it will turn to the Start button and
scanning process will stop).

You can set additional parameters before scan, such as: scan mode

(check severity level), actions over detected objects, etc. For more

information on the settings, please refer to the
section.

3.3.2. Scan Results

Scan results are shown as a table in the bottom of the Scanner
main window. See . There you can find information on
infected and suspicious objects found during the scan: their
location, their reasons to be included into the current selection and
actions performed by the program over these objects.

Items in the list of detected objects are displayed in a hierarchical
order: if a virus is found inside an archive, then the archive is
displayed as a node, which contents you can expand and collapse.
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Figure 23. Scan results

File Settings Help

P EE +- e% X

M= o Add |
Moo -Delete|

mme
‘.\ Start

¥ Scan subdirectories

File  Status

[0 B cypocuments and Settings/Copy.doc  infected with wo7M Belyash

[ 4 cyDocurments and Settings/1.doc.com infected with EICAR Test File (NOT a Wirus!)

[ 4] cyProgram Filesfadware exe contains an advertising software Adware.Dudu

4] CyfProgram Filesjupx.exe infected with Win32 HLLP Jeefo.36352

I [ Dymessages thb archive MAIL

Ad [ oyMailbase archive MAIL
i eicarcom infected with EICAR Test File (NOT a Wirus!)

<) select all é Clear list o CUrE Bgelete

Below the report field is a row of buttons where you can select the
desired action for every object in the list: Cure or Delete. The
Cure action is not available for archives, containers, and mail files.

<. If there some other action, different from Report, was specified
ﬂ for a certain type of detected objects on the Actions tab of
Scanner settings section, then the result of this action will be shown

in the Status column.

When the Cure action is assigned for an object, and this object
appears to be incurable, then the action specified for incurable
objects on the Actions tab will be applied.

To select a desired action for certain found objects manually, select
objects (or click Select all to select all objects) and click Cure or

Delete.
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4. Using Console Scanner

This section helps you get started using the Console Scanner.

4.1. Starting a Scanning

After launching in the safe mode, the Start
Menu appears. See

Figure 24. Start Menu

Welcome to Dr.Web LiveCD

Gtart Dr.Webh Scanner

Copyright (c) Igor Daniloff 1992-26889

Using the arrow keys, select one of the following items from the
menu and press ENTER:
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4, Using Console Scanner

e Start Xorg - to launch the GUI version of the ;

e Start Shell - to bring up the command line;

o Start Midnight Commander - to launch the inbuilt file
manager;

e Start Dr.Web Scanner - to start scanning all hard disk
partitions with default settings;

o Start Dr.Web Update - to update the virus databases;

e Choose Language - to change the interface language;

o Xorg Configuration - to adjust parameters of the X Window
system, if it was not configured automatically;

o Network Configuration - to adjust network parameters, if
the network was not configured automatically;

e Report Bug - to about a bug in the
product to the developers;

e Restart - to reboot the computer;

e Shut Down - to shut down the computer without ejecting
the disk;

e Eject & Shut Down - to eject the disk and shut down the
computer.

If you want to start scanning with special options, select Start
Shell. This will bring up the command line in the bottom of the
screen. To run console Scanner you can use the following
command:

$ /opt/drweb/drweb -

path <path> [ command line parameters]

where <path> - is the path to scanned directory or the mask for
checked files.

When is started only with <path> argument without any
parameters specified, it scans the specified directory using the
default set of parameters. In the following example drive C: is being
checked:

$ /opt/drweb/drweb -path /win/C:
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Command Line Parameters

supports numerous command line parameters.

They are separated from specified path by white space and are
prefixed by hyphen «-». To get complete list of parameters, start
drweb component with -2, -h or -help parameters.

Main program parameters can be classified in the following way:

Scan

scan area parameters;
diagnostics parameters;
actions parameters;
interface parameters.

area parameters determine where the virus check must be

performed. They include:

path — specify path for scan. Several paths can be specified
in one parameter;

@[ +] <file> — check objects listed in the specified file. Plus
«+» instructs Scanner not to delete files from the list of
objects after scan is completed. List file may contain paths to
directories that must be scanned regularly, or list of files to be
checked only once;

sd — recursive search and scan of files in subdirectories
starting from the current directory;

f1 — follow links, both to files and directories. Links causing
loops are ignored;

mask — ignore masks for file names.

Diagnostics parameters determining what types of objects must be
scanned for viruses:

al — scan all files on specified drive or in specified directory;
ar[d ml r][ n] — scan files in archives (ARJ, CAB, GZIP,
RAR, TAR, ZIP, etc.).

d - delete, m - move, r - rename archives containing infected
objects, n - archiver name output disabled.

Archives can be in simple (*. tar) or compressed forms (*.
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tar. bz2,*. tbz);
cn[dl m r][ n] — scan files in containers (HTML, RTF,

PowerPoint,..).
d - delete, m - move, r - rename containers containing

infected objects, n - container type output disabled;

ml[ dl m r][ n] — scan files in mailboxes.

d - delete, m - move, r - rename maiboxes, containing
infected objects; n - mailbox type output disabled;

up[ n] — scan executable files packed with LZEXE, DIET,
PKLITE, EXEPACK;

n - packer type output disabled;

ex — diagnostics using file masks (see FilesTypes
parameter in configuration file);

ha — heuristic analysis (search for unknown viruses).

Actions parameters determine what actions must be performed if
infected or suspicious files are detected. They include:

cul d ml r] — cure infected files: d - delete, m - move, r -
rename infected files;

ic[dl m r] — actions for incurable files: d - delete, m
move, r - rename incurable files;

spl dl ml r] — actions for suspicious files: d - delete, m
move, r - rename suspicious files;

adw[ d| m| r| i] — actions for files containing adware: d
delete, m - move, r - rename, i -ignore;

dls[ dl m r| 1] — actions for dialers: d - delete, m - move,
r -rename, i -ignore;

jok[ dl m r| 1] — actions for joke programs: d - delete, m -
move, r - rename, i - ignore;

rsk[dl m r| i] — actions for potentialy dangerous
programs: d - delete, m - move, r - rename, i - ignore;

hck[ dl ml x| i] — actions for hacktools: d - delete, m -
move, r - rename, i - ignore;

Interface parameters configure report output:

v, version - output information about product and
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Engine versions;

e ki — output information about key file and its owner (in UTF8
encoding only);

e foreground[ yes| no] — enable to run in
foreground or in background;

e ot — output information to standard output (stdout);

e og — disable information output;

e ok — display «Ok» for not infected files;

e log=<path to file> — logging to specified file;

e ini=<path to file> — path to alternative configuration
file;

e Ing=<path to file> — path to alternative language file.

You can use hyphen «-» postfix to disable the following parameters:
-ar -cu -ha -ic -fl -ml -ok -sd -sp

For example, if you start with the following command:
$ drweb -path <path> -ha-

heuristic analysis (enabled by default) will be disabled.

By default (if configuration was not customized and no
parameters were specified) starts with the following
parameters:

-ar -ha -fl- -ml -sd

Default parameters (including scan of archives, packed files
and mailboxes, recursive search, heuristic analysis, etc.) is sufficient
for everyday diagnostics and can be used in typical cases. You can
also use hyphen «-» postfix to disable some parameters, as it was
explained above.

Disabling scan of archives and packed files will significantly decrease
antivirus protection level, because in archives (especially, self-
extracting) enclosed in e-mail attachments viruses are distributed.
Office documents potentially susceptible to infection with macro
viruses (Word, Excel) are also dispatched via e-mail in archives and
containers.
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4, Using Console Scanner

When you run with default parameters, no actions
and no actions for incurable and suspicious files are taken. For these
actions to be performed, you must specify corresponding command
line parameters explicitly.

Set of actions parameters may vary in particular cases. We
recommend the following:
e cu — cure infected files and system areas without deletion,
moving or renaming infected files;
e icd — delete incurable files;
e spm — move suspicious files;
e spr — rename suspicious files.

When is started with Cure action specified, it wil try to
restore the previous state of infected object. It is possible only if
detected virus is known virus, and cure instructions for it are
available in virus database, though even in this case cure attempt
may fail if infected file is seriously damaged by virus.

If infected files are found inside archives they will not be cured,
deleted, moved or renamed. To cure such files you must manually

unpack archives to the separate directory and instruct to
check it.
When is started with action Delete specified, it will delete

all infected files from disk. This option is suitable for incurable
(irreversibly damaged by virus) files.

Action Rename makes replace file extension with a
certain specified extension («*. #72?» by default, i.e. first extension
symbol is replaced with «#» symbol). Enable this parameter for files
of other OS (e.g., DOS/Windows) detected heuristically as
suspicious. Renaming helps to avoid accidental startup of executable
files in these OS and therefore prevents infection by possible virus
and its further expansion.

With action Move enabled
files to the quarantine directory.

will move infected or suspicious
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5. Reporting a bug

If you use graphic shell, then to send a report about some bug in
program operation you must do the following:

pass to the main options section of the using the

Options button < on the toolbar or using the menu in the
main window: Settings -> Options;

in the main options section select Support tab;

press the Bug report button on this tab;

after that an inbuitt mail client will be started with the

message template already opened;

in the Subject field give a brief description of the problem

encountered, and in the message body describe the problem

in every detail, including the steps to be made to reproduce

it;

send the message using the default e-mail account.

If you use console, then to send a report about a bug use the
following algorithm:

using the arrow keys, select the Report Bug items from the
Start Menu and press ENTER;

a console text editor ( ) wil open, where you can
describe the encountered problem;

after finishing the description, press CTRL+X to exit the text
editor;

before exit you will be prompted to make a decision whether

you want to send the bug report or not, and press the
corresponding key (Y - to send a report, N - to discard it).
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